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How to Use This Document 

This document is intended as a sample template that can be copied and edited to suit a 
particular software engineering project.  It was assembled from a combination of 
documents [1],  [2], and [3]. 

Styles 

This document was written in Microsoft Word, and makes heavy use of styles.  The 
styles dialog is initially located on the menu bar under the “Home” tab in MS Word.  It is 
recommended that the styles dialog be pulled off into a separate window when working 
on formatting of the document.  If each paragraph is assigned a style, then modifying that 
particular style will affect all paragraphs in the document having the same style. 

The table of contents uses the document headings and sub-headings to automatically 
generate table of contents information. 

Tracking Changes and Multiple Authors 

The “Review” tab in MS Word contains several tools that are of particular use when 
editing large documents, particularly when multiple authors are involved: 

The “Tracking” section allows you to track the ( proposed ) changes to a document, and 
to step through each proposed change to either accept or reject the proposed changes. 

The “Compare” section allows you to merge changes proposed by different authors, ( 
which will be marked in separate colors for identification ), and then to use the change 
tracking tools described above to accept or deny each change. 

The recommended procedure is to start with each author having a copy of a base 
document, ( possibly this template. )  Then each author changes the section(s) they are 
responsible for, and submits their changed version to one person who acts as the overall 
document editor.  This author merges the changes, selectively accepts or rejects each 
change, and then distributes a new base document to all authors for the next round of 
changes.  It is also possible to merge the changes and then distribute the document, so 
that all authors can review the proposed changes.  ( The latter approach may be 
appropriate for documents such as bylaws, in which the changes must be approved by a 
committee or a vote before they can be accepted. ) 
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Dealing With Material that is Unwanted ( Right Now ) 

Much of this document includes material that is not needed for every project, and/or 
which may not have been written yet, and so should be removed before printing or 
distributing the document.  There are several ways to do this, however each has their 
drawbacks: 

1. Delete the material completely.  The drawback is that now it is completely 
gone, and the only way to get it back is to copy it from some other document, 
if that is even available. 

2. Change the font to "Hidden".  The drawback is that this does not affect the 
numbering of sections, either in the text or in the table of contents.  However 
the original style information is retained, so when the text is unhidden, 
individual paragraphs do not need to be restyled. 

3. Change the style to "Hidden".  This does cause the document to renumber 
properly, ( because the paragraphs are no longer numbered paragraphs ), but 
all the original style information is gone, so if it is unhidden later, then all the 
styles of all the unhidden paragraphs will have to be restored manually. 

4. Move the text, say to the end of the document, and then do not print or 
distribute the material at the end of the document.  If this is all that is done, 
then this material will continue to appear in the table of contents.  However if 
the font is also changed to "hidden", then the material will not appear in the 
TOC, but all the original style information will be retained.  The drawback to 
moving the text is that now you need to keep track of where the information 
was moved from, in case you ever want to move it back. 

Hidden text can be made visible by selecting the backwards "P" paragraph  mark on the 
"Home" tab. 

Table of Contents 

The table of contents lists the sections of the document and the page upon which each 
section starts.  The table of contents may or may not include subsections, etc. 

Microsoft Word ( and many similar programs ) has the ability to generate a table of 
contents automatically from section headings, and to update it when the document 
changes.  The table of contents included in this template is automatically generated by 
MS Word, and can be updated by selecting the table and clicking on the menu that 
appears above the table at that time. 

Note:  Remove all instructional materials before finalizing and 
submitting this document, including this entire page and the 
one before it. 
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( The title above is formatted as Heading 3, so that it appears in the table of contents, but was 
then modified to be centered and include a page break before the paragraph.  Likewise for the 
List of Tables heading on the next page.. ) Note:  Remove this instructional paragraph. 

If a document contains a large number of figures, then it is appropriate to include a list of figures 
at the beginning of the document, following the table of contents.  Each figure should include a 
title, and be numbered in a consistent logical fashion. The following list of figures was 
automatically generated from figure captions ( see Figure 1 on page 11 ), and can be 
automatically updated by right-clicking on the table below and selecting “Update Field”.  This 
feature is located in the “Captions” section of the “References” tab in MS Word.  Note:  Remove 
this instructional paragraph. 

Figure 1 - Sample Image of a Survey Dive Boat .......................................................................... 11 

On a related note, the references in the paragraph above, “( see Figure 1 on page 11 )” include 
cross-references to the Figure and page number that will adjust automatically when other Figures 
or pages are added or removed.  This is done with the “cross-reference” button in the “Captions” 
section of the “References” tab in MS Word. Note:  Remove this instructional paragraph. 
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If a document contains a large number of tables, then it is appropriate to include a list of tables at 
the beginning of the document, following the table of contents.  Each table should include a title, 
and be numbered in a consistent logical fashion.  The following list of tables was automatically 
generated from table captions ( see below), and can be automatically updated by right-clicking 
on the table below and selecting “Update Field”.  This feature is located in the “Captions” 
section of the “References” tab in MS Word.  Note:  Remove this instructional paragraph. 
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The following sample table and figure are only here to initialize the list of figures and list of 
tables above.  They should be removed when real ones are included in the document.  ( I.e. 
delete this entire page when you can. ) 

 

Date Participants Activities Notes 

    

    

    

Table 1- Sample Table of Survey Dive Activity 

 

Figure 1 - Sample Image of a Survey Dive Boat   
( photo by Tony Kiefer ) 
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I Project Description 

1 Project Overview 

A brief description of the product to be produced, before getting into details. 

2 The Purpose of the Project  

2a The User Business or Background of the Project Effort 

Content 

content, motivation, examples and Considerations 

A short description of the business being done, its context, and the situation that 
triggered the development effort. It should also describe the work that the user intends 
to do with the delivered product.  

Motivation 

Without this statement, the project lacks justification and direction. 

Considerations 

You should consider whether the user problem is serious, and whether and why it 
needs to be solved.  

2b Goals of the Project 

( Note:  This item and the following one together cover the " Objectives and success 
criteria of the project" item specified by Bruegge & DuToit. ) 

Content 

This boils down to one sentence, or at most a few sentences, that say why we want 
this product. Here is where you state the real reason the product is being developed.  

Motivation 

There is a danger that this purpose may get lost along the way. As the development 
effort heats up, and as the customer and developers discover more about what is 
possible, the system could potentially wander away from the original goals as it 
undergoes construction. This is a bad thing unless there is some deliberate act by the 
client to change the goals. It may be necessary to appoint a person to be custodian of 
the goals, but it is probably sufficient to make the goals public and periodically 
remind the developers of them. It should be mandatory to acknowledge the goals at 
every review session. 

Examples 
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We want to give immediate and complete response to customers who order our goods 
over the telephone.  

We want to be able to forecast the weather. 

2c Measurement  

Any reasonable goal must be measurable. This is necessary if you are ever to test 
whether you have succeeded with the project. The measurement must quantify the 
advantage gained by the business through doing the project. If the project is 
worthwhile, there must be some solid business reason for doing it. For example, if the 
goal of the project is  

We want to give immediate and complete response to customers who order our goods 
over the telephone. 

you have to ask what advantage that goal brings to the organization. If immediate 
response will result in more satisfied customers, then the measurement must quantify 
that satisfaction. For example, you could measure the increase in repeat business (on 
the basis that a happy customer comes back for more), the increase in customer 
approval ratings from surveys, the increase in revenue from returning customers, and 
so on.  

It is crucial to the rest of the development effort that the goal is firmly established, is 
reasonable, and is measured. It is usually the latter that makes the former possible.  

 

3 The Scope of the Work 

This section describes the ( business ) environment in which the product will be used. 

3a The Current Situation 

Content 

This is an analysis of the existing business processes, including the manual and 
automated processes that might be replaced or changed by the new product. Business 
analysts might already have done this investigation as part of the business case 
analysis for the project. 

Motivation 

If your project intends to make changes to an existing manual or automated system, 
you need to understand the effect of proposed changes. The study of the current 
situation provides the basis for understanding the effects of proposed changes and 
choosing the best alternatives.  Knowing what users are doing now can give insight 
into their views of a proposed new system. 
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3b The Context of the Work 

Content 

The work context diagram identifies the work that you need to investigate to be able 
to build the product. Note that it includes more than the intended product. Unless we 
understand the work that the product will support, we have little chance of building a 
product that will fit cleanly into its environment. 

The adjacent systems on the context diagram (e.g., Weather Forecasting Service) 
indicate other subject matter domains (systems, people, and organizations) that need 
to be understood. The interfaces between the adjacent systems and the work context 
indicate why we are interested in the adjacent system. In the case of Weather 
Forecasting Service, we can say that we are interested in the details of when, how, 
where, who, what, and why it produces the District Weather Forecasts information. 

Motivation 

To clearly define the boundaries for the study of the work and requirements effort. 
Without this definition, we have little chance of building a product that will fit 
seamlessly into its environment. 
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Examples 

 

 

Considerations 

The names used on the context diagram should be consistent with the naming 
conventions and data dictionary definitions presented in section 5. Without these 
definitions, the context model lacks the required rigor, and it may be misunderstood. 
Relevant stakeholders must agree to the definitions of the interfaces shown on the 
context model.  
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3c Work Partitioning 

Note:  Volere talks of dividing up the work according to the different business events 
to which the business must respond.  However each response to a business event is 
effectively a use-case, so Volere’s list of business events is effectively the same as a 
use-case diagram and a descriptive list of the associated use-cases. 

Content 

A list showing all business events to which the work responds. Business events are 
happenings in the real world that affect the work. They also happen because it is time 
for the work to do something—for example, produce weekly reports, remind 
nonpaying customers, check the status of a device, and so on. The response to each 
event is called a business use case; it represents a discrete partition of work that 
contributes to the total functionality of the work.  

The event list includes the following elements: 

● Event name 

● Input from adjacent systems (identical with name on context diagram) 

● Output to adjacent systems (identical with name on context diagram) 

● Brief summary of the business use case (This is optional, but we have found it is a 
very useful first step in defining the requirements for the business use case—you can 
think of it as a mini-scenario.)  

Motivation 

To identify logical chunks of the system that can be used as the basis for discovering 
detailed requirements. These business events also provide the subsystems that can be 
used as the basis for managing detailed analysis and design. 
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Example 
    Business Event List 

 
Event Name  Input and Output   Summary 
1. Weather Station 
transmits reading 

Weather Station 
Readings (in) 

Record the readings as 
belonging to the weather 
station. 

2. Weather Service 
forecasts weather 

District Weather 
Forecast (in) 

Record the forecast. 

3. Road engineers advise 
changed roads 

Changed Road (in) Record the new or changed 
road. Check that all 
appropriate weather stations 
are attached.  

4. Road Engineering 
installs new Weather 
Station 

New Weather Station 
(in) 

Record the weather station 
and attach it to the 
appropriate roads.  

5. Road Engineering 
changes Weather Station 

Changed Weather 
Station (in) 

Record the changes to the 
weather station. 

6. Time to test Weather 
Stations 

Failed Weather 
Station Alert (out) 

Determine if any weather 
stations have not transmitted 
for two hours, and inform 
Road Engineering of any 
failures.  

7. Truck Depot changes a 
truck 

Truck Change (in) 
 

Record the changes to the 
truck.  

8. Time to detect icy 
roads 

Road De-icing 
Schedule (out) 

Predict the ice situation for 
the next two hours. Assign a 
truck to any roads that will 
freeze. Issue the schedule.  

9. Truck treats a road Treated Road (in) Record the road as being in 
a safe condition for the next 
three hours.  

10 Truck Depot reports 
problem with truck 

Truck Breakdown (in) 
Amended Gritting 
Schedule (out) 

Reassign available trucks to 
the previously assigned 
roads.  

11. Time to monitor road 
treatment 

Untreated Road 
Reminder (out) 

Check that all scheduled 
roads have been treated in 
the assigned time, and issue 
reminders for any untreated 
roads.  

   

Considerations 

Attempting to list the business events is a way of testing the work context. This 
activity uncovers uncertainties and misunderstandings about the project and facilitates 
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precise communications. When you do an event analysis, it will usually prompt you 
to make some changes to your work context diagram. 

We suggest you gather requirements for discrete sections of the work. This requires 
you to partition the work, and we have found business events to be the most 
convenient, consistent, and natural way to break the work into manageable units.  

3d Competing Products 

Content 

Other alternatives that already exist can be described here.  Why should we go to all 
the trouble of creating a new product?  What flaws or deficiencies do the existing 
products have that justify the creation of something new? 

Motivation 

Knowing what other choices the customer has to choose from can help us judge 
whether or not our project is even worth doing, and if so, what we need to do 
different to be better than the available alternatives. 

Considerations 

Note the subtle difference between this item and the “Off the Shelf” solutions 
documented in sections 6d or 35 below.  The latter refers to software that we can buy 
and incorporate into our solution. 

4 Product Scenarios 

Scenarios are somewhat informal stories describing how the end users would use the 
product once it is completed.  They take the form of narratives and may involve 
specific individuals and examples. 

4a Product Scenario  List 

The product scenario list is quite simply a list of the product scenarios that will 
appear in the next section.  It is a good idea to either number or name each scenario 
for later reference, and it can also be a good idea to organize the list so that related 
scenarios appear together.  ( Depending on the naming / numbering scheme, they can 
be grouped into sections and subsections, etc. ) 

4b Individual Product Scenarios 

Product scenarios are written in a natural narrative fashion, easily understood by 
clients and other non-technical stakeholders.  Each one tells a story of how the end 
users are expected to eventually use the finished product.  For example: 

Monthly Reports:  At the end of every month Mary has to generate the monthly 
reports, and distribute copies to all the managers and sub-managers.  The first 
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thing she has to do is to make sure that all the end-of-the-month tests have been 
run, and that everyone else is logged off of the system.  Then she selects the date 
range and the specific information she wants included in her reports, selects either 
the long or short format, and selects a printer.  Depending on how busy the month 
has been, it may take as long as fifteen minutes, during which time no one else 
can use the system.  She only prints one copy on the computer, and then makes all 
the rest of the copies she needs on the copy machine. 

5 Stakeholders  

5a The Client  

Content 

This item gives the name of the client. It is permissible to have several names, but 
having more than three negates the point. 

Motivation 

The client has the final say on acceptance of the product, and thus must be satisfied 
with the product as delivered. You can think of the client as the person who makes 
the investment in the product. Where the product is being developed for in-house 
consumption, the roles of the client and the customer are often filled by the same 
person. If you cannot find a name for your client, then perhaps you should not be 
building the product. 

Considerations 

Sometimes, when building a package or a product for external users, the client is the 
marketing department. In this case, a person from the marketing department must be 
named as the client. 

5b The Customer 

Content 

The person intended to buy the product. In the case of in-house development, the 
client and the customer are often the same person. In the case of development of a 
mass-market product, this section contains a description of the kind of person who is 
likely to buy the product.  

Motivation 

The customer is ultimately responsible for deciding whether to buy the product from 
the client. The correct requirements can be gathered only if you understand the 
customer and his aspirations when it comes to using your product.  
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5c Hands­On Users of the Product  

Content 

A list of a special type of stakeholder—the potential users of the product. For each 
category of user, provide the following information:  

● User name/category: Most likely the name of a user group, such as 
schoolchildren, road engineers, or project managers. 

● User role: Summarizes the users’ responsibilities.  

● Subject matter experience: Summarizes the users’ knowledge of the business. 
Rate as novice, journeyman, or master.  

● Technological experience: Describes the users’ experience with relevant 
technology. Rate as novice, journeyman, or master.  

● Other user characteristics: Describe any characteristics of the users that have an 
effect on the requirements and eventual design of the product. For example:  

Physical abilities/disabilities 

Intellectual abilities/disabilities 

Attitude toward job 

Attitude toward technology 

Education 

Linguistic skills 

Age group 

Gender 

Motivation 

Users are human beings who interface with the product in some way. Use the 
characteristics of the users to define the usability requirements for the product. Users 
are also known as actors. 

Examples 

Users can come from wide variety of (sometimes unexpected) sources. Consider the 
possibility of your users being clerical staff, shop workers, managers, highly trained 
operators, the general public, casual users, passers-by, illiterate people, tradesmen, 
students, test engineers, foreigners, children, lawyers, remote users, people using the 
system over the telephone or an Internet connection, emergency workers, and so on.  
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5d Priorities Assigned to Users 

Content 

Attach a priority to each category of user. This gives the importance and precedence 
of the user. Prioritize the users as follows: 

● Key users: They are critical to the continued success of the product. Give greater 
importance to requirements generated by this category of user.  

● Secondary users: They will use the product, but their opinion of it has no effect on 
its long-term success. Where there is a conflict between secondary users’ 
requirements and those of key users, the key users take precedence. 

● Unimportant users: This category of user is given the lowest priority. It includes 
infrequent, unauthorized, and unskilled users, as well as people who misuse the 
product.  

The percentage of the type of user is intended to assess the amount of consideration 
given to each category of user.  

Motivation 

If some users are considered to be more important to the product or to the 
organization, then this preference should be stated because it should affect the way 
that you design the product. For instance, you need to know if there is a large 
customer group who has specifically asked for the product, and for which, if they do 
not get what they want, the results could be a significant loss of business.  

Some users may be listed as having no impact on the product. These users will make 
use of the product, but have no vested interest in it. In other words, these users will 
not complain, nor will they contribute. Any special requirements from these users will 
have a lower design priority. 

5e User Participation 

Content 

Where appropriate, attach to the category of user a statement of the participation that 
you think will be necessary for those users to provide the requirements. Describe the 
contribution that you expect these users to provide—for example, business 
knowledge, interface prototyping, or usability requirements. If possible, assess the 
minimum amount of time that these users must spend for you to be able to determine 
the complete requirements.  

Motivation 

Many projects fail through lack of user participation, sometimes because the required 
degree of participation was not made clear. When people have to make a choice 
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between getting their everyday work done and working on a new project, the 
everyday work usually takes priority. This requirement makes it clear, from the 
outset, that specified user resources must be allocated to the project. 

5f Maintenance Users and Service Technicians 

Content 

Maintenance users are a special type of hands-on users who have requirements that 
are specific to maintaining and changing the product.  

Motivation 

Many of these requirements will be discovered by considering the various types of 
maintenance requirements detailed in section 14. However, if we define the 
characteristics of the people who maintain the product, it will help to trigger 
requirements that might otherwise be missed. 

5g Other Stakeholders 

Content 

The roles and (if possible) names of other people and organizations who are affected 
by the product, or whose input is needed to build the product. 

Examples of stakeholders: 

● Sponsor 

● Testers 

● Business analysts 

● Technology experts 

● System designers 

● Marketing experts 

● Legal experts 

● Domain experts 

● Usability experts 

● Representatives of external associations  

For a complete checklist, download the stakeholder analysis template at 
www.volere.co.uk. 
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For each type of stakeholder, provide the following information: 

● Stakeholder identification (some combination of role/job title, person 
name, and organization name) 

● Knowledge needed by the project 

● The degree of involvement necessary for that stakeholder/knowledge 
combination 

● The degree of influence for that stakeholder/knowledge combination 

● Agreement on how to address conflicts between stakeholders who have an 
interest in the same knowledge 

Motivation 

Failure to recognize stakeholders results in missing requirements.  

 

6 Mandated Constraints 

This section describes constraints on the eventual design of the product. They are the 
same as other requirements except that constraints are mandated, usually at the 
beginning of the project. Constraints have a description, rationale, and fit criterion, 
and generally are written in the same format as functional and nonfunctional 
requirements. 

6a Solution Constraints  

Content 

This specifies constraints on the way that the problem must be solved. Describe the 
mandated technology or solution. Include any appropriate version numbers. You 
should also explain the reason for using the technology. 

Motivation 

To identify constraints that guide the final product. Your client, customer, or user 
may have design preferences, or only certain solutions may be acceptable. If these 
constraints are not met, your solution is not acceptable. 

Examples 

Constraints are written using the same form as other atomic requirements (refer to the 
requirements shell for the attributes). It is important for each constraint to have a 
rationale and a fit criterion, as they help to expose false constraints (solutions 
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masquerading as constraints). Also, you will usually find that a constraint affects the 
entire product rather than one or more product use cases. 

Description: The product shall use the current two-way radio system to 
communicate with the drivers in their trucks. 

Rationale: The client will not pay for a new radio system, nor are any other means 
of communication available to the drivers.  

Fit criterion: All signals generated by the product shall be audible and 
understandable by all drivers via their two-way radio system.  

 

Description: The product shall operate using Windows XP. 

Rationale: The client uses XP and does not wish to change.  

Fit criterion: The product shall be approved as XP compliant by the MS testing 
group.  

  

Description: The product shall be a hand-held device. 

Rationale: The product is to be marketed to hikers and mountain climbers.  

Fit criterion: The product shall weigh no more than 300 grams, no dimension shall 
be more than 15 centimeters, and there shall be no external power source.  

Considerations 

We want to define the boundaries within which we can solve the problem. Be careful, 
because anyone who has experience with or exposure to a piece of technology tends 
to see requirements in terms of that technology. This tendency leads people to impose 
solution constraints for the wrong reason, making it very easy for false constraints to 
creep into a specification. The solution constraints should only be those that are 
absolutely non-negotiable. In other words, however you solve this problem, you must 
use this particular technology. Any other solution would be unacceptable. 

6b Implementation Environment of the Current System 

Content 

This describes the technological and physical environment in which the product is to 
be installed. It includes automated, mechanical, organizational, and other devices, 
along with the nonhuman adjacent systems.  



25 
 

Motivation 

To describe the technological environment into which the product must fit. The 
environment places design constraints on the product. This part of the specification 
provides enough information about the environment for the designers to make the 
product successfully interact with its surrounding technology. 

The operational requirements are derived from this description. 

Examples 

Examples can be shown as a diagram, with some kind of icon to represent each 
separate device or person (processor). Draw arrows to identify the interfaces between 
the processors, and annotate them with their form and content. 

Considerations 

All component parts of the current system, regardless of their type, should be 
included in the description of the implementation environment. 

If the product is to affect, or be important to, the current organization, then include an 
organization chart.  

6c Partner or Collaborative Applications 

Content 

This describes applications that are not part of the product but with which the product 
will collaborate. They can be external applications, commercial packages, or 
preexisting in-house applications. 

Motivation 

To provide information about design constraints caused by using partner applications. 
By describing or modeling these partner applications, you discover and highlight 
potential problems of integration. 

Examples 

This section can be completed by including written descriptions, models, or 
references to other specifications. The descriptions must include a full specification of 
all interfaces that have an effect on the product. 

Considerations 

Examine the work context model to determine whether any of the adjacent systems 
should be treated as partner applications. It might also be necessary to examine some 
of the details of the work to discover relevant partner applications. 


